# Table of Contents

A Start-up List of Finance INB Forms ................................................................. 1
Log-on and log-off for Banner............................................................................. 2
Starting with GUAGMNU and Form Names....................................................... 3
Navigating INB Forms: Explore on Your Own! ................................................. 4
Querying Information – Wildcard Search Aids .................................................... 4
Encumbrance Inquiry Forms ............................................................................. 5
Procurement Inquiry Forms .............................................................................. 5
Transaction Inquiry Forms .............................................................................. 6
Document Inquiry Forms .................................................................................. 6
Grant Inquiry Forms ......................................................................................... 7
Budget Inquiry Forms ....................................................................................... 7
General Ledger Inquiry Forms ......................................................................... 8
Endowment Form ............................................................................................... 8
Chart of Accounts (Maintenance) Forms............................................................ 8
Hierarchy Inquiry Forms .................................................................................. 8
INB Navigation and Forms Exercises, Using FY09: ......................................... 9
Answer Key ....................................................................................................... 10
Keyboard Shortcuts............................................................................................ 19
Form Names – What Do They Mean? ............................................................... 20

## A Start-up List of Finance INB Forms

### Encumbrance Inquiry Forms
- FGIOENC  Organizational Encumbrance List (Open)
- FGIENC  Encumbrance List
- FGIENC  Detail Encumbrance Activity Form

### Procurement Inquiry Forms
- FPIPURR  Purchase Order Inquiry Form
- FOIODOCH  Document History (Procurement Process)
- FPIOPOV  Open Purchase Orders by Vendor Form
- FPIOPOD  Purchase Order Validation Form
- FPIOPOF  Open Purchase Orders by FOAPAL
- FAINVE  Invoice/Credit Memo Query
- FAIQINF  Open Invoice by FOAPAL
- FAIVNDH  Vendor Detail History Form
- FAIVHIS  Vendor History Query Form
- FAIVINV  Vendor Invoice History Form

### Transaction Inquiry Forms
- FGITRND  Operating Accounts Transaction Detail

### Document Inquiry Forms
- FGIDOCE  Document Retrieval Inquiry
- FGJVC  List of Suspended Journal Vouchers

### Grant Inquiry Forms
- FRIGITD  Grant Inception to Date
- FRAGRNT  Grant Maintenance

### Budget Inquiry Forms
- FGIBDSR  Executive Summary Form
- FGIBST  Organizational Budget Status Form
- FGIBAVL  Budget Availability Status Form
- FGIBSUM  Organizational Budget Summary Form

### General Ledger Inquiry Forms
- FGITBAL  General Ledger Trial Balance
- FGITBSR  Trial Balance Summary Form
- FGIGLAC  General Ledger Transaction Detail

### Endowment Form
- FNEMEDW  Endowment Fund Definition

### Chart of Accounts (Maintenance) Forms
- FTMFUND  Fund Manager, Effective Dates
- FTMORGN  Orgn Manager, Effective Dates
- FTMACCTS  Account Code Maintenance
- FTMORGN  Program Code Maintenance

### Hierarchy Inquiry Forms
- FTIFNDH  Fund Hierarchy Query
- FTIORGH  Organization Hierarchy Query
- FTACTH  Account Hierarchy Query
- FTIPRGH  Program Hierarchy Query
- FTIOCH  Location Hierarchy Query
Log-on and log-off for Banner

A. Logon to Banner

1. You will use your Banner Oracle ID (license plate) and password.

2. Access to Banner INB Production is available in Raiderlink’s Top Menu:

   ![Banner INB Production Access](image)

   a. An empty/blank window, ‘Oracle Fusion Middleware Forms Services” is opened and may appear in the task bar at the bottom of your monitor.

   b. If RaiderLink is unavailable, or if multiple Banner windows are desired, an alternate link is available on the AFISM website:

   RaiderLink > A&F Work Tools > AFISM ‘Home’ > ERP Tools > TTUSPRD
   -or- www.depts.ttu.edu/afism/

   Use this link to open multiple windows!

3. At the Logon window enter your Banner “Oracle ID “and password. Leave Database empty, and press ENTER or click CONNECT.

4. An additional window, ‘Oracle Fusion Middleware Forms Services” is opened with Banner General Menu GUAGMNU, seen in the blue band immediately above a Welcome greeting to you (illustration on next page). The Banner window is represented by this icon on the task bar at the bottom of your monitor.
B. **Logout (from the general menu, GUAGMNU)**

   **CAUTION:** If the empty/blank window opened in step 2.a is exited, it will automatically close the Banner window and all forms that are open!!

   1. Be sure all Banner forms are closed. Click the Form exit (black X on the icon bar) to close any forms that are open.
   2. To exit Banner,
      a. Either click the Form exit (black X on the icon bar), or click the window exit.
      b. Reminder Window: Are you sure you want to exit this Banner session? Click YES.
      c. Close the additional window, “Oracle Fusion Middleware Forms Services”

C. **Your Banner (Oracle) ID and Password**

   1. From Raiderlink, access **TeamApp** under A&F Work Tools tab/AFISIM, OR directly access at: [http://team.texastech.edu](http://team.texastech.edu) with your eRaider ID and password)

   2. Your Oracle ID will be displayed.

   3. Enter a new Password and click on “set password” to change your password.

**Starting with GUAGMNU and Form Names**

The General Menu, GUAGMNU, is the front door of Banner.
Navigating INB Forms: Explore on Your Own!

**MENU BAR:**

| File | Edit | Options | Block | Item | Record | Query | Tools | Window | Help |

**ICON BAR:**

**BLOCK:**

How many icons perform block functions? _________________________

Is the background image ___ a page ___ blocks ___ a round stack?

**RECORD:**

How many icons perform record functions? _________________________

Is the background image ___ a page ___ blocks ___ a round stack?

**QUERY:**

How many icons perform query functions? _________________________

Is the background image ___ a page ___ blocks ___ a round stack?

**OTHER:**

What other icons do you see that you already know? _________________

**MENU BAR:**

How many choices are available on the:

- Block Menu _____
- Item Menu _____
- Record Menu _____
- Query Menu _____

What choices do you recognize on the File menu? _________________

Why is the First Letter of the menu descriptors is underlined?

For Keyboard Shortcuts, see page 19.

**Querying Information – Wildcard Search Aids**

Querying allows you to search for information stored in Banner. Some forms automatically open in query mode (will show in the help line); others will have to be put in query mode to run queries.

**SEARCH WILDCARDS:**

- `%` Any combination before or after your entry.
- `_` Any character in this column.

**Examples:**

- Entries that contain “ma” %ma%
- Entries that begin with “ma” ma%
- Entries that have “ma” as the last two characters %ma
- Entries that have “m” as the first and third character m_m
- Entries that have “m” as the second character _m%
## Encumbrance Inquiry Forms

**FGIOENC**  
Organizational Encumbrance List  
Can enter by Fund only, Org only or both  
Provides list of open encumbrances by Org or Fund or both  
Use Options to open  
- Query Detail Encumbrance Info `[FGIENCD]`

**FGIENCD**  
Detail Encumbrance Activity  
Requires Document Number  
Provides detailed transaction activity for an original encumbrance and transaction activity against that encumbrance (Description, Balance, Vendor, FOAPAL, Encumbrance Amount, Liquidation Amount, Invoice Information)  
*Does not provide Receiver and Check information*  
This is a query only form

**FGIENC**  
Encumbrance List  
Query any encumbered document  
Provides Description, Current Balance, Status (open, closed, etc.), dates  
This is a query only form

## Procurement Inquiry Forms

**FPIPURR**  
Purchase Order Inquiry Form  
Requires Purchase Order or Blanket Order Number  
This is a query only form

**FOIDOCH**  
Document History  
Requires Purchase Order or Invoice or Check or Asset  
Use Options to open Purchase Order [FPIPURR], Invoice [FAIINVE], Check Payment History [FAICHKH], Asset Tags/Adjustments

**FPIOPOV**  
Open Purchase Orders by Vendor Form  
Requires Vendor, Status (Open, Closed, Cancelled, Incomplete, All)  
Provides PO Number, Description, Date, Quantity, UOM and Amount

**FPIPOHD**  
Purchase Order Validation Form  
Query by PO or Blanket Number, PO Date, Delivery Date, Vendor  
Use Options to open  
- Commodities for Review Query [FOICOMM]  
  - Commodities and Accounting [FOICACT]  
- Purchase/Blanket/Change Order [FPIPURR]
FPIOPOF  Open Purchase Orders by FOAPAL
Search by any of the following: Chart, Fund, Organization, Account, and Program
Use Options to open Purchase Order [FPIPURR], Commodities [FOICOMM]

FAIINVE  Invoice/Credit Memo Query
Requires Invoice Number
Provides invoice detail

FAIOINF  Open Invoice by FOAPAL
Search by Chart, Fund, Organization, Account and/or Program
Provides Invoice, Vendor, Description and Amount

FAIVNDH  Vendor Detail History Form
Requires Vendor
Provides Vendor Invoice, AP Invoice Doc ID, Invoice Amount, Check Date, Check Number
Use Options to open Invoice [FAAINVE], Commodity Information [FOICOMM], and Vendor Invoice [FAIVINV]

FAIVHIS  Vendor History Query Form
Requires Vendor
Search by All, Cancelled, Not Cancelled
Use Options to open: Credit Memos, Open Invoices, and Paid Invoices

FAIVINV  Vendor Invoice History Form
Requires Vendor, Document Number
Provides Vendor invoice, date, total, status, and items

Transaction Inquiry Forms

FGITRND  Detail Transaction Activity
Can query by any FOAPAL combination plus first row of the next block (Account, Organization, Program, Document, Description, Fund, Amount, Fund Balance) and each of these columns is searchable
Use Options to open
• Query Transaction Source Info (by type) [FGIDOCR]
• Detail Encumbrance Info [FGIENCD] (For encumbrance docs only)

Only on this form, FGITRND: Use the Help Menu > Extract Data No Key to transfer results to Excel for further analysis.

Document Inquiry Forms

FGIDOCR  Document Retrieval Inquiry
Requires Document Number
Provides document detail information including FOAPAL
Use Options to open
• Document Posting Information [FGQDOCP]

FGIJVCD  List of Suspended Journal Vouchers
Provides Document, Description, Amount, Transaction Date, Status
This is a query only form
Grant Inquiry Forms

FRIGITD  Grant Inception to Date
Requires COA and Grant; Can search by Account Type and any combination of FOAPAL
Shows Account Type, Adjusted Budget, Activity, Commitments and Available Balance
Use Options to open
- Grant Transaction Detail Form [FRIGTRD]
  o Query Document by Type
  o Encumbrance Detail [FGIENCD]
  o Query Total for all Records

FRAGRNT  Grant Maintenance
Shows Grant, Principal Investigator, Agency, Amount, Status, Project Dates, Sponsor ID, Responsible Organization
This is a query only form.

Budget Inquiry Forms

FGIBDSR  Executive Summary for Budget
Can enter by Fund only, Org only or both
Provides Adjusted Budget, YTD Activity, Commitments and Available Balance by Account
  Allows for queries at higher level chart components within the chart hierarchy
Use Options to open
- Transaction Detail Information [FGITRND]
  o Query Document (by type)
  o Detail Encumbrance Activity [FGIENCD]

FGIBDST  Organization Budget Status
Can enter by Fund only, Org only or both
Provides Adjusted Budget, YTD Activity, Commitments and Available Balance by Account
  Will not return values for queries at higher level chart components within the chart hierarchy
Use Options to open
- Budget Summary Information [FGIBSUM]
  o Organization Budget Status [FGIBDST]
- Organization Encumbrance List [FGIOENC]
  o Detail Encumbrance Activity [FGIENCD]
- Transaction Detail Information [FGITRND]

FGIBAVL  Budget Availability Status
Requires Fund, Org, Account
Shows budget availability for a FOAP as of the current system date, including suspended, unapproved and unposted documents
Provides Adjusted Budget, YTD Activity, Commitments and Available Balance
  This is a query only form.
FGIBSUM Organization Budget Summary
Can enter by Fund only, Org only or both
Provides Adjusted Budget, YTD Activity, Commitments and Available Balance by Account Type (ie Revenue, Direct Expenditures, etc.)
Use Options to open
- Budget Status Information [FGIBDST]
- Organization Encumbrances [FGIOENC]
- Transaction Detail Information [FGITRND]

General Ledger Inquiry Forms

FGITBAL General Ledger Trial Balance
Requires Fund; can also enter Account Type and/or Account
Provides Account, Description and Balances
Use Options to open
- Query General Ledger Activity [FGIGLAC]
  - Query Transaction Source Info (by type) [FGIDOCR]

FGITBSR Trial Balance Summary
Requires Fund or Fund Type; can also enter Account and/or Account Type
Provides Account Type, Description, Balances
Use Options to open
- Query General Ledger Activity [FGIGLAC]
  - Query Transaction Source Info (by type) [FGIDOCR]

FGIGLAC General Ledger Activity
Requires Fund; Can also enter Account
Provides GL account, document ID, description, Amount,
Use Options to open
- Query Transaction Source Info (by type)

Endowment Form

FNMENDW Endowment Fund Definition
Provides Endowment Fund Definitions

Chart of Accounts (Maintenance) Forms

FTMFUND Fund Manager, Effective Date
FTMORGN Orgn Manager, Effective Date
FTMACCT Account Codes
FTMPROG Program Codes

Hierarchy Inquiry Forms

FTIFNDH Fund Hierarchy Query
FTIORGH Organization Hierarchy Query
FTIACCT Account Hierarchy Query
FTIPRGH Program Hierarchy Query
FTILOCH Location Hierarchy Query
INB Navigation and Forms Exercises, Using FY09:

1. Look up the budget (FGIBDST) for:
   a. 11A007 B53000 400
   b. Open 7C0181 (FGITRND)
   c. Open Detail Encumbrance Info
2. Look up Clearing Account 18A090 for FY09 (FGITBAL)
   a. Open 2A0073 activity
   b. Look up FY10 activity
3. Look up transaction detail activity (FGITRND)
   a. 11A007 B53000 400
   b. Enter a query to look up 7C0 account codes only
   c. Open one of the documents listed
4. Look up PO information
   a. P0027649 (FGIENC)
      i. How many records are there?
      ii. Is the PO open?
      iii. Search Encumbrance List
          1. Enter Query
          2. Search for %PURC8S% in description
          3. Search for only open documents that start with PU
5. Look up PO Document History
   a. P0000745 (FOIDOCH)
      i. Open PO
      ii. Open invoice
      iii. Open check (bank code 31)
          1. Look up vendor invoice number
          iv. Open asset tag
6. Look up open PO by FOAP (FPIOPOF)
   a. 11A007 B53000 400
      i. View Commodities
      ii. View Purchase Order
7. Look up Vendor Detail History (FAIVNDH)
   a. Search for Goodwin Powell Office Supplies
   b. How many invoices have been paid for FY10?
   c. What is the vendor invoice number?
   d. View Commodity
   e. View Invoice
8. Who is the Orgn Manager for B51004 (FTMORGN)
   a. Who was the previous Orgn manager and when was it changed?
9. Who is the Fund Manager for 17A019 (FTMFUND)
   a. Who was the previous fund manager?
10. Look up document (FGIDOCR)
    a. Look up budget BD0J9664
1. **Look up the budget (FGIBDST) for:**
   a. 11A007 853000 400
   b. Open 7C0181 (FGITRND)
   c. Open Detail Encumbrance Info

**Answer:** Enter FGIBDST from main menu in Go To section; Enter

**Note** – Uncheck Include Revenue Accounts* see info below

1.a. Enter Chart, FY, Organization, Fund and Program – Next Block

1.b. Next Record (arrow down) to account code 7C0181

1.c. Click on Options; Detail Encumbrance Info FGIENCD

*Uncheck Include Revenue Accounts*
Note: Use the black X from the icon menu to close out forms and get back to main page.

*Include Revenue Accounts Checkbox

<table>
<thead>
<tr>
<th>Chart:</th>
<th>T</th>
<th>Organization:</th>
<th>B53000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Year:</td>
<td>10</td>
<td>Fund:</td>
<td>11A007</td>
</tr>
<tr>
<td>Index:</td>
<td></td>
<td>Program:</td>
<td>400</td>
</tr>
<tr>
<td>Query Specific Account</td>
<td></td>
<td>Account:</td>
<td></td>
</tr>
<tr>
<td>Include Revenue Accounts</td>
<td></td>
<td>Account Type:</td>
<td></td>
</tr>
<tr>
<td>Commit Type:</td>
<td>Both</td>
<td>Activity:</td>
<td></td>
</tr>
<tr>
<td>Location:</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Results leaving checked:

| 7C0110 | E | MS Consumables Office | 826.00 | -23.75 | 826.00 | 23.75 |
| 7C0131 | E | MS Furnish/Equip Noncapita | 11,915.70 | 19,468.93 | 11,462.00 | 94.99 |
| 7C0181 | E | MS Parts Computer Equip N | 476.40 | 167.90 | 308.50 | 9.99 |
| 7C0200 | E | MS Computer Equip Control | 9,204.83 | 9,204.83 | 0.00 | 0.00 |

Net Total: 5,978,633.01 | | -151,227.04 | | 868,671.09 |

Results unchecked:

| 7C0110 | E | MS Consumables Office | 826.00 | -23.75 | 826.00 | 23.75 |
| 7C0131 | E | MS Furnish/Equip Noncapita | 11,915.70 | 19,468.93 | 11,462.00 | 94.99 |
| 7C0181 | E | MS Parts Computer Equip N | 476.40 | 167.90 | 308.50 | 9.99 |
| 7C0200 | E | MS Computer Equip Control | 9,204.83 | 9,204.83 | 0.00 | 0.00 |

Net Total: 1,076,603.01 | | 151,227.06 | | 55,871.09 | 50,535.76

2. **Look up Clearing Account 18A090 for FY09 (FGITBAL)**
   a. Open 2A0073 activity
   b. Look up FY10 activity

**Answer:**
Enter FGITBAL from main menu in Go To section; Enter

2.a. **Enter Chart, FY and Fund - Next Block**

![General Ledger Trial Balance](image-url)
Arrow down and highlight 2A0073 and click on Options from menu bar

From Options Select Query General Ledger Activity Info (FGIGLAC)

2.b. Close FGIGLAC with black X from icon bar and use the rollback icon to return to the header of FGITBAL. Change FY to 10 and Next Block.
3. Look up transaction detail activity (FGITRND)
   a. 11A007 B53000 400
   b. Enter a query to look up 7C0 account codes only
   c. Open one of the documents listed

   **Answer:** Enter FGITRND from main menu in Go To section; Enter
   3.a Enter Chart, FY, FOP - Next Block

   3.b. Form begins in query mode. Enter 7C0% in Account Field and Execute Query (F8).

   3.c. Use Arrow keys or scroll bar to highlight a transaction line; click on Options; Query Document by type

4. Look up PO information
   a. P0027649 (FGIENCD)
      i. How many records are there?
      ii. Is the PO open?
      iii. Search Encumbrance List
          1. Enter Query
          2. Search for %PURC85% in description
          3. Search for only open documents that start with PU

   **Answer:** Enter FGIENCD from main menu in Go To section; Enter
   4.a. Enter P0027649 in Encumbrance field of FGIENCD – Next Block
4.a.i. Use Next Record icon or arrow down key to view records for this PO.

4.a.ii. Status indicates Open or Closed Encumbrance (not if line item or record is closed)
4.a.iii Search Encumbrance List from Header by clicking on search icon next to encumbrance field

Enter Query (F7), type in query criteria and execute query (F8)

NOTE: double click on the encumbrance number or highlight and use the select icon to view encumbrance information.

5. **Look up PO Document History**
a. P0000745 (FOIDOCH)
   i. Open PO
   ii. Open invoice
   iii. Open check (bank code 31)
      1. Look up vendor invoice number
   iv. Open asset tag

**Answer:** Enter FOIDOCH from main menu in Go To section; Enter
5.a Enter Document Type (PO) and Document Code P0000745 – Next Block

6. **Look up open PO by FOAP (FPIOPOF)**
a. 11A007 BS3000 400
   i. View Commodity
ii. View Purchase Order

**Answer:** Enter FPIOPOF from main menu in Go To section; Enter

6.a. Enter Chart and FOP – Next Block

![COA Index Fund Orgn Acct Prog](chart.png)

Using arrow keys, select purchase order you wish to view. Use Options to View Commodities or Purchase Order

7. **Look up Vendor Detail History (FAIVNDH)**

a. Search for Goodwin Powell Office Supplies
b. How many invoices have been paid for FY10?
c. What is the vendor invoice number?
d. View Commodity
e. View Invoice

**Answer:** Enter FPIOPOF from main menu in Go To section; Enter

7.a. Use the search icon to find the R# for Goodwin Powell Office Supplies

Select the FTIIDEN link. Form begins in query mode, enter criteria and execute query \(F8\).

Find the vendor from the search results and double click or use the select icon \(\text{ eldreame }\). Use the tab key to populate Vendor name from R#. Next Block
8. **Who is the Orgn Manager for B51004 (FTMORGN)**

   a. Who was the previous Orgn manager and when was it changed?

   **Answer:** Enter FTMORG from main menu in Go To section; Enter
   
   8.a. Enter a Query and then use the search icon to search for a specific organization or type in chart and organization. Execute Query.

   Tab cursor to Financial Manager field and next record (arrow down) to see previous financial manager(s). Look at Effective Date.

   ![Diagram of Financial Manager field with query and search options highlighted]

   **1. Enter a Query**
   **2. Enter or Search for Orgn**
   **3. Execute Query**
9.  **Who is the Fund Manager for 17A019 (FTMFUND)**
   a.  Who was the previous fund manager?

   **Answer:** Enter FTMFUND from main menu in Go To section; Enter
   9.a. Enter a Query and then use the search icon to search for a specific fund or type in chart and fund. Execute Query.

   Tab cursor to Financial Manager field and next record (arrow down) to see previous financial manager(s). Look at Effective Date.

10. **Look up document (FGIDOCR)**
    a.  Look up budget BD0J9664

    **Answer:** Enter FGIDOCR from main menu in Go To section and Enter. Enter document number and Next Block

    Document: BD0J9664
# Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Function Group</th>
<th>Key(s)</th>
<th>ALT-Menu, &amp; Icons</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic Functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Keys</td>
<td>CTRL + F1</td>
<td>N/A</td>
</tr>
<tr>
<td>Save Changes</td>
<td>F10</td>
<td>File/Save</td>
</tr>
<tr>
<td>Print</td>
<td>Shift + F8</td>
<td>File/Print</td>
</tr>
<tr>
<td>Clear Form and Rollback</td>
<td>Shift + F7</td>
<td>File/Rollback</td>
</tr>
<tr>
<td>Exit Form</td>
<td>CTRL + Q</td>
<td>File/Exit</td>
</tr>
<tr>
<td><strong>Block Functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Next Block</td>
<td>CTRL + Page Down</td>
<td>Block/Next</td>
</tr>
<tr>
<td>Previous Block</td>
<td>CTRL + Page Up</td>
<td>Block/Previous</td>
</tr>
<tr>
<td>Clear Block</td>
<td>Shift + F5</td>
<td>Block/Clear</td>
</tr>
<tr>
<td><strong>Record Functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Next Record</td>
<td>Down Arrow</td>
<td>Record/Next</td>
</tr>
<tr>
<td>Previous Record</td>
<td>Up Arrow</td>
<td>Record/Previous</td>
</tr>
<tr>
<td>Clear Record</td>
<td>Shift + F4</td>
<td>Record/Clear</td>
</tr>
<tr>
<td>Insert Record</td>
<td>F6</td>
<td>Record/Insert</td>
</tr>
<tr>
<td>Duplicate Record</td>
<td>F4</td>
<td>Record/Duplicate</td>
</tr>
<tr>
<td>Remove Record</td>
<td>Shift + F6</td>
<td>Record/Remove</td>
</tr>
<tr>
<td><strong>Item/Field Functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Next Field</td>
<td>Tab</td>
<td>Item/Next</td>
</tr>
<tr>
<td>Previous Field</td>
<td>Shift + Tab</td>
<td>Item/Previous</td>
</tr>
<tr>
<td>List of Values/Flashlight</td>
<td>F9</td>
<td>Help/List</td>
</tr>
<tr>
<td>Next Primary Key...........</td>
<td>Shift + F3</td>
<td>N/A</td>
</tr>
<tr>
<td>Clear Field</td>
<td>CTRL + U</td>
<td>Item/Clear</td>
</tr>
<tr>
<td>Duplicate Field</td>
<td>F3</td>
<td>Item/Duplicate</td>
</tr>
<tr>
<td>Next Radio Button Item</td>
<td>Right Arrow</td>
<td>N/A</td>
</tr>
<tr>
<td>Prev Radio Button Item</td>
<td>Left Arrow</td>
<td>N/A</td>
</tr>
<tr>
<td>Ck/Unck Check Box Field</td>
<td>Space Bar</td>
<td></td>
</tr>
<tr>
<td><strong>Query Functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Query</td>
<td>F7</td>
<td>Query/Enter</td>
</tr>
<tr>
<td>Execute Query</td>
<td>F8</td>
<td>Query/Execute</td>
</tr>
<tr>
<td>Exit Query with Value</td>
<td>Shift + F3</td>
<td>N/A (Click OK?)</td>
</tr>
<tr>
<td>Count Query Hits</td>
<td>Shift + F2</td>
<td>Query/Count Hits</td>
</tr>
</tbody>
</table>
## Form Names – What Do They Mean?

<table>
<thead>
<tr>
<th>Position 1: Identifies the System owning the Form, Report, Job, or Table</th>
<th>Position 2: Identifies the Module owning the Form, Report, Job, or Table</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A</strong> Alumni/Development</td>
<td><strong>L</strong> Occupational tax/license</td>
</tr>
<tr>
<td><strong>B</strong> Property Tax</td>
<td><strong>N</strong> Position Control</td>
</tr>
<tr>
<td><strong>C</strong> Courts</td>
<td><strong>O</strong> Customer Contact</td>
</tr>
<tr>
<td><strong>D</strong> Cash Drawer</td>
<td><strong>P</strong> HR/Payroll/Personnel</td>
</tr>
<tr>
<td><strong>E</strong> Finance</td>
<td><strong>Q</strong> Electronic Work Queue</td>
</tr>
<tr>
<td><strong>F</strong> General</td>
<td><strong>R</strong> Financial Aid</td>
</tr>
<tr>
<td><strong>G</strong> Information Access</td>
<td><strong>S</strong> Student</td>
</tr>
<tr>
<td><strong>K</strong> Work Management</td>
<td><strong>T</strong> Accounts Receivable</td>
</tr>
</tbody>
</table>

Position 2:

<table>
<thead>
<tr>
<th>General (G)</th>
<th>Student (S)</th>
<th>Finance (F)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>E</strong> Event Management</td>
<td><strong>A</strong> Admissions</td>
<td><strong>A</strong> Accounts Payable</td>
</tr>
<tr>
<td><strong>J</strong> Job Submissions</td>
<td><strong>C</strong> Catalog</td>
<td><strong>B</strong> Budget Development</td>
</tr>
<tr>
<td><strong>L</strong> Letter Generation</td>
<td><strong>E</strong> Support Services</td>
<td><strong>C</strong> Cost Accounting</td>
</tr>
<tr>
<td><strong>O</strong> Overall</td>
<td><strong>F</strong> Registration/Fee Asmnt</td>
<td><strong>E</strong> Electronic Data Interchange</td>
</tr>
<tr>
<td><strong>P</strong> Purge</td>
<td><strong>G</strong> General Student</td>
<td><strong>F</strong> Fixed Assets</td>
</tr>
<tr>
<td><strong>S</strong> Security</td>
<td><strong>H</strong> Grades/Acad History</td>
<td><strong>G</strong> General Ledger</td>
</tr>
<tr>
<td><strong>T</strong> Validation Form/Table</td>
<td><strong>I</strong> Faculty Load</td>
<td><strong>I</strong> Investment Management</td>
</tr>
<tr>
<td><strong>U</strong> Utility</td>
<td><strong>K</strong> Reserved for SCT Int.</td>
<td><strong>O</strong> Operations</td>
</tr>
<tr>
<td><strong>X</strong> Cross Product</td>
<td><strong>L</strong> Location Management</td>
<td><strong>P</strong> Purchasing/Procurement</td>
</tr>
</tbody>
</table>

**Accounts Receivable (T):**

<table>
<thead>
<tr>
<th><strong>M</strong> CAPP</th>
<th><strong>R</strong> Research Accounting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>O</strong> Overall</td>
<td><strong>S</strong> Stores Inventory</td>
</tr>
<tr>
<td><strong>P</strong> Person</td>
<td><strong>T</strong> Validation Form/Table</td>
</tr>
<tr>
<td><strong>R</strong> Recruiting</td>
<td><strong>U</strong> Utility</td>
</tr>
<tr>
<td><strong>S</strong> Scheduling</td>
<td><strong>X</strong> Archive/Purge</td>
</tr>
<tr>
<td><strong>T</strong> Validation Form/Table</td>
<td><strong>U</strong> Utility</td>
</tr>
</tbody>
</table>

**Financial Aid (R):**

<table>
<thead>
<tr>
<th><strong>B</strong> Budgeting</th>
<th><strong>A</strong> Application</th>
<th><strong>S</strong> Student</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>C</strong> Record Creation</td>
<td><strong>B</strong> Budget</td>
<td><strong>R</strong> Financial Aid</td>
</tr>
<tr>
<td><strong>E</strong> Electronic Data Exchange</td>
<td><strong>C</strong> COBRA</td>
<td></td>
</tr>
<tr>
<td><strong>F</strong> Funds Management</td>
<td><strong>D</strong> Benefit/Deductions</td>
<td></td>
</tr>
<tr>
<td><strong>H</strong> History &amp; Transcripts</td>
<td><strong>E</strong> Employee</td>
<td></td>
</tr>
<tr>
<td><strong>J</strong> Student Employment</td>
<td><strong>H</strong> Time Reporting/History</td>
<td></td>
</tr>
<tr>
<td><strong>L</strong> Logging</td>
<td><strong>O</strong> Overall</td>
<td></td>
</tr>
<tr>
<td><strong>N</strong> Need Analysis</td>
<td><strong>P</strong> General Person</td>
<td></td>
</tr>
<tr>
<td><strong>O</strong> Common Functions</td>
<td><strong>R</strong> Electronic Approvals</td>
<td></td>
</tr>
<tr>
<td><strong>P</strong> Packaging &amp; Disbursements</td>
<td><strong>S</strong> Security</td>
<td></td>
</tr>
<tr>
<td><strong>R</strong> Requirements Tracking</td>
<td><strong>T</strong> Validation Table/Form</td>
<td></td>
</tr>
</tbody>
</table>

**HR/Payroll (P) or Position (N):**

<table>
<thead>
<tr>
<th><strong>B</strong> Budgeting</th>
<th><strong>A</strong> Application</th>
<th><strong>S</strong> Student</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>C</strong> Record Creation</td>
<td><strong>B</strong> Budget</td>
<td><strong>R</strong> Financial Aid</td>
</tr>
<tr>
<td><strong>E</strong> Electronic Data Exchange</td>
<td><strong>C</strong> COBRA</td>
<td></td>
</tr>
<tr>
<td><strong>F</strong> Funds Management</td>
<td><strong>D</strong> Benefit/Deductions</td>
<td></td>
</tr>
<tr>
<td><strong>H</strong> History &amp; Transcripts</td>
<td><strong>E</strong> Employee</td>
<td></td>
</tr>
<tr>
<td><strong>J</strong> Student Employment</td>
<td><strong>H</strong> Time Reporting/History</td>
<td></td>
</tr>
<tr>
<td><strong>L</strong> Logging</td>
<td><strong>O</strong> Overall</td>
<td></td>
</tr>
<tr>
<td><strong>N</strong> Need Analysis</td>
<td><strong>P</strong> General Person</td>
<td></td>
</tr>
<tr>
<td><strong>O</strong> Common Functions</td>
<td><strong>R</strong> Electronic Approvals</td>
<td></td>
</tr>
<tr>
<td><strong>P</strong> Packaging &amp; Disbursements</td>
<td><strong>S</strong> Security</td>
<td></td>
</tr>
<tr>
<td><strong>R</strong> Requirements Tracking</td>
<td><strong>T</strong> Validation Table/Form</td>
<td></td>
</tr>
</tbody>
</table>

**Information Access (I):**

| **W** Reserved for Client applications that co-exist with Banner 7 |

| **Z** | **All Products** | **W** Reserved for Client applications that co-exist with Banner 7 |

**Utility**

- **U** Utility
- **W** Reserved for Client applications that co-exist with Banner 7
### Position 3: Identifies the Type of Form, Report, Job, or Table

<table>
<thead>
<tr>
<th>General (G)</th>
<th>Student (S)</th>
<th>Finance (F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Application Form</td>
<td>A Application Form</td>
<td>A Application Form</td>
</tr>
<tr>
<td>B Base Table</td>
<td>B Base Table</td>
<td>B Base Table</td>
</tr>
<tr>
<td>I Inquiry Form</td>
<td>I Inquiry Form</td>
<td>I Inquiry Form</td>
</tr>
<tr>
<td>O Online COBOL Process</td>
<td>P Process</td>
<td>M Maintenance Form</td>
</tr>
<tr>
<td>Q Query Form</td>
<td>Q Query Form</td>
<td>Q Query Form</td>
</tr>
<tr>
<td>R Rule Table</td>
<td>R Rule Table</td>
<td>R Rule Table</td>
</tr>
<tr>
<td>Repeating Table</td>
<td>Repeating Table</td>
<td>Repeating Table</td>
</tr>
<tr>
<td>Reports/Process</td>
<td>Reports/Process</td>
<td>Reports/Process</td>
</tr>
<tr>
<td>V Validation Form/Table View</td>
<td>V Validation Form/Table View</td>
<td>V Validation Form/Table View</td>
</tr>
<tr>
<td>T General Maintenance</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Financial Aid (R)</th>
<th>HR/Payroll/Personnel (P)</th>
<th>Accounts Receivable (T)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Application Form</td>
<td>A Application Form</td>
<td>A Application Form</td>
</tr>
<tr>
<td>B Base Table</td>
<td>B Base Table</td>
<td>I Inquiry Form</td>
</tr>
<tr>
<td>I Inquiry Form</td>
<td>I Inquiry Form</td>
<td>P Process</td>
</tr>
<tr>
<td>P Process/Report</td>
<td>P Process</td>
<td>Q Query Form</td>
</tr>
<tr>
<td>R Rule Table</td>
<td>R Rule Table</td>
<td>R Report</td>
</tr>
<tr>
<td>Repeating Table</td>
<td>Repeating Table</td>
<td>V Validation Form/Table View</td>
</tr>
<tr>
<td>Reports/Process</td>
<td>Reports/Process</td>
<td></td>
</tr>
<tr>
<td>T Temporary Table</td>
<td></td>
<td>Information Access (I)</td>
</tr>
<tr>
<td>V Validation Form/Table View</td>
<td></td>
<td>R Report</td>
</tr>
</tbody>
</table>

### Positions 4, 5, 6, 7

Identify a unique, four-character name for the Form, Report, Process, or Table

<table>
<thead>
<tr>
<th>SPAIDEN</th>
<th>PPAIDEN</th>
<th>FAABATC</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>P</td>
<td>F</td>
</tr>
<tr>
<td>P</td>
<td>P</td>
<td>A</td>
</tr>
<tr>
<td>A</td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td>IDEN</td>
<td>IDEN</td>
<td>BATC</td>
</tr>
<tr>
<td>S</td>
<td>P</td>
<td>F</td>
</tr>
<tr>
<td>A</td>
<td>P</td>
<td>G</td>
</tr>
<tr>
<td>A</td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td>ADM</td>
<td>GENL</td>
<td>ENCB</td>
</tr>
<tr>
<td>S</td>
<td>P</td>
<td>F</td>
</tr>
<tr>
<td>A</td>
<td>P</td>
<td>A</td>
</tr>
<tr>
<td>A</td>
<td>I</td>
<td>A</td>
</tr>
<tr>
<td>DETL</td>
<td>IDEN</td>
<td>2AME</td>
</tr>
</tbody>
</table>